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1.6.4 **Decision-support instrument for the Assessment of Considerations for Water Use Applications (ACWUA) 
1.6.5 **Guideline on pro-forma licence conditions for the Resource Directed Management of Water Quality 
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Stress of the Water Resource 
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1. System 
This guide provides assistance to users of the software package (RWQO Model vs. 4.0) 
for the determination of Resource Water Quality Objectives (RWQOs) for surface water 
resources.  For detail on the methodology behind this system, the user is referred to the 
"Guideline for determining Resource Water Quality Objectives (RWQOs), Allocatable 
Water Quality and the Stress of the Water Resource" (DWAF, 2006), accessible from 
within the Model or on the enclosed CD.  The software is freely available from the 
Department of Water Affairs and Forestry. 

2. Setup 
 
■ Software Version 

This Users Guide is applicable to version 4.0 of the RWQOs Model, developed by the 
CSIR for the Department of Water Affairs and Forestry (DWAF). 

 
■ Setting up 

 
The RWQOs Model is a computer-based application which can be run either from the 
setup CD or from a computer.  To run the Model from the CD locate and open the file 
run.bat.  To run the Model from the computer, the user should copy the relevant folder and 
associated files from the CD and paste them into a folder created for the application. 

 

 
 

The Model is a standalone application and requires no additional software to run.  Should 
users wish to open any of the available documents within the Model [See Functions], they 
will need Acrobat Reader.  The setup file for Acrobat Reader is enclosed on the attached 
CD or can be downloaded from www.adobe.com. 

 

 

Copy and paste 
or drag folder to 
your computer. Note: replace with file 

structure once 
transferred onto CD. 
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3. System Requirements 
There are no specific system requirements to operate the RWQOs Model.   

4. Quick Start 
What you need to know and do to get started: 
 
1. Copy the folder from the CD to your computer 
2. Locate and Open the file run.bat 
3. You are now ready to begin a new project, or an existing saved project. 

 

 
 

5. Overview 
The RWQOs Model (vs 4.0) provides users with a standard approach to consistently 
setting Resource Water Quality Objectives (RWQOs) for surface water resources in South 
Africa.  By selecting the water resource and user requirements, the Model generates 
RWQOs that are based on a database of provided and entered water quality parameters. 

The Model provides a quick approach to setting RWQOs based on the guidelines for 
determining Resource Water Quality Objectives (RWQOs), Allocatable Water Quality and 
the Stress of the Water Resource (DWAF, 2006). 
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6. Functions 
The Model provides two levels of functions; these are accessible through the Toolbar and 
through the Tabs. 

 

 
 
 

■ Toolbar 

Toolbar options include: 
• File  
• Tools 
• Help 

 

 
 

 
 

 
 

■ Tabs 

The 'Tabs' provide an overview of each of the working screens in the Model, namely: 
• Introduction • Monthly-Flow 

• Input • End-of-Pipe 

• Best AEMC • Report 

• References 

Toolbar 
Tabs 

The 'File' dropdown menu on the toolbar, 
allows users to create a new project, 
open an already saved project, save a 
project, save a report, or print a report. 

The 'Tools' dropdown menu on the 
toolbar, allows users to easily convert a 
number of flow units into the required flow 
format of m3/s and vice versa. 

The 'Help' dropdown menu on the 
toolbar, allows users to access 
supporting documents, e.g. guidelines, 
legislation; access to on-line help; and 
information about the software version. 
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♦ Introduction 
The 'Introduction' tab provides users with a brief overview and background to the Model. 
 

♦ Input 
The 'Input' tab is the main input screen in the Model.  Here users are required to: 
1) Select (or enter) the Recommended Ecological Category (Best AEMC) for the water 

resource management unit;  
2) Select the desired management class for the water resource management unit; 
3) Set the spatial extent of the water resource management unit; 
4) Select the desired target flows to support the determination of loads; 
5) Select the desired water user categories (current and future); and 
6) Enter present and reference water quality for selected parameters of concern. 

 

 

Each of these steps is briefly unpacked below. 

 
v Recommended ecological category 

The Recommended ecological category (REC) (sourced from the Best AEMC) provides 
the starting default category for the ecological Reserve category [under Users].  To select 
the REC the user should go to the BestAEMC tab and select the appropriate quaternary 
catchment.  By doing so, the Best AEMC will automatically be filled into the Input screen. 

 

(1) Select Best AEMC 

(2) Select management 
class 

(3) Select spatial extent 

(4) Select flow 

(5) Select desired 
water user category 

(6) Present and 
Reference water quality 

Select REC 
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v Desired management class  

 

The Management Class, for the water resource management unit, provides the starting or 
default category for the other Water Users [under Users] - [Natural=Ideal; Moderately 
used/impacted=Acceptable; Heavily used/impacted=Tolerable].  The Management Class 
can be selected from the available drop down menu. 

 

 
 

 
 
 
v Spatial extent of the water resource management unit 

The spatial extent defines the water resource management unit for the study.  This is used 
for supporting information and is not used in any of the calculations to determine the 
RWQOs. 

 

 
 
v Target flows and flow assurance 

The flow is used in the Model to determine the allocatable load and the end-of-pipe 
discharges.  Once flows have been entered in the Monthly-Flow tab, the desired temporal 
extent and flow assurance should be selected.  This will automatically insert the target 
flow into the required field.  Flows may be edited by clicking on the Edit Flow Table button. 

 

v Desired water user categories (current and future) 

The desired water user categories, both existing and future are fundamental to 
determining the RWQOs. 

 

The user can choose to keep the 
REC or deselect, to allow a different 
ecological Reserve category to be 

entered. 

Best AEMC and 
default ecological 
Reserve category 

The user can choose to keep the 
Management Class or deselect this, 

to allow different Water User 
categories to be selected. 

Select Management 
Class 

Select Spatial 
Extent 

Select Temporal 
Extent 
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v Present and reference water quality for selected parameters of concern 

 

The present water quality is used to determine the water resource stress [See Reports], 
while the reference water quality provides data to assess the feasibility of the determined 
RWQOs. 

 

 

♦ Best AEMC 
The 'Best Achievable Ecological Management Category (Best AEMC)' tab allows users to 
automatically select the Recommended Ecological Category for a given quaternary 

Ecological Reserve 
category may be 

changed from default 

Water User categories 
may be changed from 

default 

Existing and future 
water users should 

be selected 

Present and reference 
water quality can be 
entered by the user 
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catchment.  The Best AEMC was determined by specialists with local knowledge of the 
various catchments (Kleynhans, 1999). 

 

 
 

♦ References 
The 'Reference tab’ provides the input water quality data for various water user types, and 
is used to determine the RWQOs.  For certain water users, the water quality data are 
automatically provided in the Model [Reference tab], based on the South African Water 
Quality Guidelines (DWAF, 1996) (e.g. Domestic Use, Agriculture, Industrial, and 
Recreation) – these are accessible under Help > Supporting Documents.  In addition, 
default water quality data are provided for Ecological Requirements (in the absence of an 
ecological reserve) (Palmer et al., 2005) and Basic Human Needs (Class 1) (WRC, 1998). 

If applicable to the catchment, users are required to enter the water quality in the 
'Reference' tab for: 

• International obligations; 
• Strategic use; and 
• Ecological Reserve. 

 

Users can sort alphabetically 
by quaternary catchment or 

by stream name 

Category selected provides 
the default Ecological 

Reserve Category 
Select desired 

quaternary catchment 
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The ecological Reserve water quality data are entered for the selected ecological Reserve 
category, as determined from the Reserve process. 

 

 
 

Reference water quality 
from the South African 

Water Quality Guidelines 

Water quality to be 
entered for the selected 

ecological Reserve 
category 

Additional variables may be 
added to the References 

which will appear in the Input 
and Report worksheets  
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If an Ecological Reserve has not been set for the water resource 
management unit, the Model will automatically use the 'Ecological 
Requirements' (Palmer et al., 2005) for the default Ecological Reserve 
Category, as determined from the Best AEMC.  

♦ Monthly Flow 
Target flows and flow assurances are used to set the 'Allocatable Load', i.e. the water 
quality over and above that required for the RWQOs, i.e. that which can be allocated for 
use. 

The flows are entered into the 'Monthly Flow' tab.  This can be done in two possible ways, 
either by: 
• Typing the monthly flows into a given flow assurance column, e.g. 10%, or 
• Importing the monthly flows as derived from the SPATSIM database (*.rul file), i.e. 

the output of the Reserve process. 
 

The monthly flows can be imported as either m3/s or Mm3/month.  If the 
SPATSIM *.rul file is being imported, it is important that the header rows 
remain in the file.  The Model will read these lines, to determine the 
import flow units. 

 
 

To import flow data, click the                       button in the 'Monthly-Flow' tab.  This will take 
users to an 'Open' screen where you can locate the file for import. 

 

These header rows 
should not be deleted 

from the import *.rul file 

 
 

What units 
should the 
flows be in? 

 
 

There is no 
ecological 
Reserve? 
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Once imported, the 'Monthly-Flow' tab will be populated with flow assurance values to be 
used in the Input Tab. 

 

 
 

Locate *.rul file 
for import 
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Monthly flow data are sourced from the SPATSIM database, obtainable 
from the Chief Directorate RDM.  Flows should be requested for the point 
or catchment for which the RWQOs are being set. 

 

If you need to edit the monthly flows after having imported the *.rul file, 
you can do this by clicking on the                         button in the 'Input' tab 
or by clicking on the           button in the Monthly-Flow tab. 

♦ End-of-pipe 
The 'End-of-Pipe' tab, allows users to work back to point source effluent discharges, to 
determine the end-of-pipe discharge(s) that may be allowed in order to achieve the RWQOs.  
The 'End-of-Pipe' tab makes use largely of data that have already been entered within the 
other tabs.  The only data to be entered in the 'End-of-Pipe' tab are the data for 'Effluent 
Flow'. 
 

 
 
 

Automatically filled from 
target flow (Input tab) 

Automatically filled 
from present water 
quality (Input tab) 

Automatically filled 
from calculated 

RWQOs (Report tab) 
Calculated by 

Model based on 
input data 

To be entered by user 

 
 
How do I edit 
flows after I 

have imported 
them? 

 
 

Where do I 
get monthly 

flows? 
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Effluent Concentration (Cw) 

 
The Effluent Concentration (Cw) calculated in the Model is the total allocatable effluent 
quality – this may be assigned to a single user or to multiple users.  It is up to the 
user to determine how the effluent concentration will be assigned within a catchment 
or river reach. 

 

♦ Report 
Having entered all of the necessary data into the input screen, the user may view the 
results in the 'Report' tab.  The report provides a: 
(1) review of the present and reference water quality, and  
(2) results of:  

• RWQOs; 
• Resource stress;,  
• The allocatable water quality and associated confidence; and 
• The allocatable loads. 

 

 
 
 
 
 
 

Selected input 
parameters 

Selected input 
parameters 

Resultant 
RWQOs 

Allocatable 
water quality 

System 
stress 
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Parameters of Concern 

 
For the RWQOs of a particular variable to appear in the 'Report' tab, that variable must 
have been selected in the 'Input' tab as a parameter of concern.  This should be done 
by     the required variable. 

 

 

The Model determines the RWQOs by selecting the lowest or most 
sensitive water quality, for each variable of concern, for each selected 
water user (existing and future).  The water quality requirements are 
extracted from entered water quality data (Reserve, International 
Obligations, Strategic Use) and default SA Water Quality Guideline data. 

The stress of the resource is the difference between the proposed 
RWQOs and the present water quality. 
 

RWQOs > Present = unstressed (water quality available for allocation) 

RWQOs < Present = stressed (no water quality available for allocation) 

 
Saving and Exporting  the results 

 
Reports that have been generated for a project can be saved or printed, allowing users 
to modify input criteria and assess the impact of these changes on the resultant 
RWQOs. 
 
The results can be exported as either 'tab delimited text' or in 'comma separated 
format'.  The 'tab delimited text' option allows users to open the report in e.g. Notepad, 
MS Word, WordPerfect, while the 'comma separated format' allows users to open the 
report in e.g. MS Excel. 
 
To export or save the report, go to >> File >> Save Report.  Select either 'As tab 
delimited text' or 'In comma separated format'. 

 

 
 
 
 

 
 
How are the 

RWQO 
determined by 

the Model? 

 
 
How is Stress 
determined by 

the Model? 
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7. Data requirements 
To determine RWQOs, the Model requires the following input data: 
• Ecological category – from a Reserve or Best AEMC 
• Management Class – from a catchment visioning exercise 
• Target flows – from Reserve output - *.rul files 
• Existing and future water users within the water resource management unit 
• Present water quality – 5th and 95th percentiles 
• Reference water quality – 5th and 95th percentiles 
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